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Welcome to the Quantrix Modeler DataNAV User Guide Supple-
ment. This guide is written for people that are familiar with Quantrix 
Modeler and have a working knowledge of database functionality and 
structures.

DataNAV is a Quantrix Modeler plugin that allows you to Navigate 
Analyze and Visualize the data created from an external database.

To use DataNAV you must have Quantrix Modeler Professional 
Edition installed on your computer. 
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Introduction
Introduction
Quantrix DataNAV allows you to easily import and aggregate data from a 
database, data warehouse or text file into your Quantrix model. The 
DataNAV functionality allows you to easily drag and drop database columns 
as dimensions or data items. DataNAV uses the power of the Database to 
execute aggregation queries and allows you to quickly get the results you 
need. 

Professional Edition:  DataNAV can only be used with 
Quantrix Modeler Professional Plus Edition.

Installing & Licensing DataNAV
DataNAV is included with the Quantrix Modeler Professional Plus installa-
tion package for Windows and OS X. All Trial Users of Quantrix get access 
to the Professional Plus edition. A purchased Professional Plus serial 
number will enable the DataNAV functionality. If you need additional assis-
tance with the Quantrix Modeler installation, you can email Quantrix 
support at support@quantrix.com.

Setting Maximum Memory
To aid in the performance of large model files, you can increase the memory 
allocation for Quantrix. We recommend that you keep the memory size 
under the amount of RAM installed on your system. To change the memory 
setting, follow these steps:

1. Choose Tools > Options to open the Options dialog box.
2. Select the General section of the Options dialog box.
3. Set the desired value in the Maximum Memory box.
4. Click the OK button to apply the option.

After you select OK, the system will test your new settings to ensure that the 
contiguous block of memory available is not exceeded. You will be 
prompted to lower the number if needed.

Caution:  On Windows operating systems, setting the memory higher 
than the operating system configuration allows may result in Quantrix not 
running. Values at or below 800M are safe in most configurations, but the 
maximum value depends on software installed on your system. If Quantrix 
Quantrix Modeler DataNAV User Guide Supplement



3
Quantrix DataNAV

Establishing a Data Source
fails to run after you make this change, please contact 
support@quantrix.com or visit the knowledge base at www.quantrix.com 
for further information.

Establishing a Data Source

Setting up the Database Driver
Quantrix can connect to databases using JDBC or, on Windows operating 
systems, ODBC. JDBC and ODBC drivers are available that can connect to 
all major database technologies. These drivers are available from your 
database vendor or third party developers. Please contact your database 
administrator or database software vendor for information on driver avail-
ability. See “Setting Database Options” on page 69 of the Quantrix Modeler 
User Guide for more information on adding JDBC drivers to Quantrix.

Note:  JDBC connections generally are faster and more robust than 
ODBC connections when used with Quantrix.

Note:  To use an ODBC connection, you must first have configured an 
ODBC Data Source on your Windows based computer. Please contact your 
database administrator for more information on configuring an ODBC 
Data Source.

Adding a Data Source
Choose Data > DataNAV > Data Sources or click the Data Source icon 
( ) in the toolbar. You will be presented with the Data Sources Panel as 
shown below:. 

Click on the Add Data Source icon ( ) to start the Data Source Wizard.
Quantrix Modeler DataNAV User Guide Supplement
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Establishing a Data Source
Tip:  Quantrix also allows you to add an existing data source from another 
model via Copy (Ctrl+C) and Paste (Ctrl+V).

Adding a JDBC / ODBC Data Source
By choosing the DataNAV JDBC/ODBC Data Source option, you are 
establishing a direct link to the database to execute aggregation queries. You 
can use any existing JDBC or ODBC connection to establish the database 
connection. 

An example connection to an Oracle database is shown below.

Once the connection is established, you can navigate the Oracle schemas 
and tables; adding tables as desired to be part of the data source.
Quantrix Modeler DataNAV User Guide Supplement
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Tip:  Generally you only need to bring in a single table. Quantrix will 
inspect the table and if foreign key constraints are present in the database 
Quantrix will link the joined tables automatically. If foreign key constraints 
are not present you can manually establish the joins. See “Add Join Table” 
on page 27 for more details.

Click Next > to proceed to the Naming table panel. See “Name New Data 
Source” on page 19 for more information.

Adding a Local Data Source

To connect to a text or csv file, use the local data source option. All connec-
tions import data into a Quantrix “column store” database for SQL queries. 
This option allows you to bring in information from databases to be made 
available for ‘off line’ use where a live connection to the data source would 
not be required. To add a local data source, follow these steps:
Quantrix Modeler DataNAV User Guide Supplement
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1. Choose the data source type based upon the location and type of data 
you would like to import. You may view a description of each type by 
clicking once on the labels in the Data source: list in the Data 
Source Wizard window. Select the data source type to configure by 
highlighting the desired type from the list in the Data Source 
Wizard window and clicking Next >.

You have 5 options to choose from:
• Delimited Text File
• Fixed Width File
• JDBC / ODBC Data Source
• Web Services / SOAP
• XML Data Source

After establishing a connection to a data source, you will use the Data 
Source Wizard to setup the parameters of the query and verify the data 
being brought into Quantrix. 

2. Configure the Data Source: See “Configuring Data Sources” on 
page 8 for a more detailed description of each destination type. 

3. Once you have configured the data source, the Data Source Wizard 
will display the grid of data coming from the data source. 
Quantrix Modeler DataNAV User Guide Supplement
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Establishing a Data Source
Figure a-1. Data Preview Screen of Data Source Wizard

4. Confirm that the data looks like you expect it to, and click Next > to 
proceed to the name table panel. See “Name New Data Source” on 
page 19 for more information.

Tip:  In addition to creating a new data source, Quantrix allows you to add 
from a previously created library of data sources. For more information see 
“Using the Data Source Library” on page 33.
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Configuring Data Sources

Using Delimited Text Files / CSV
If you selected to import your data from a Delimited Text File the Data 
Source Wizard will look like what is shown in Figure a-2.

Figure a-2. Selecting Text File to Import in Data Source Wizard

Follow these steps to configure this data source:

1. Select the delimited text file (.csv or .txt) by one of the following 
methods:
• Click Browse... and use the standard file browser to locate and 

select the desired file.
• Type the full path to the desired file.

2. Once a valid file is selected, click Next > to get to a screen shown in 
Figure a-3

Figure a-3. Setting Text File Delimiters in Data Source Wizard
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
3. If necessary, change the Field delimiter setting to match your file's 
field delimiter by placing a check in the appropriate delimiter’s 
checkbox. The Data preview grid will update to reflect your changes 
as you make them.

4. Set the Delimiter options:
• Coalesce consecutive delimiters, if checked, will cause multiple 

delimiter characters in a row to be treated as one. This can 
sometimes be used to import fixed-field-width text files.

• Field qualifier is the character that surrounds fields which could 
contain delimiter characters.

5. Optionally specify a number of rows or columns to skip in the 
import file using the Skip drop-down menus.

6. The File encoding option allows you to choose either US-ASCII 
encoding or one of three UTF encoding options that enable Asian 
character readability.

7. When you are satisfied with these settings, click Next > to get to a 
screen like shown in Figure a-4.

Figure a-4. Setting Data Types in Data Source Wizard

8. Confirm the data-type for each imported column by clicking on each 
column in the Data preview grid and checking the Data type and 
Include column in import settings fields. Change these settings if 
necessary.

9. Select First row is column header if the first row in the data file is a 
header for the columns.

10. Click Next >, and continue with Step 3 on page 6 to complete the 
data source setup.
Quantrix Modeler DataNAV User Guide Supplement
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Using Fixed Width Files
If you selected to import your data from a Fixed Width File (Step 1 on 
page 6) in the Data Source Wizard, follow these steps to configure this data 
source:

1. Select the fixed width file by one of the following methods:
• Click Browse... and use the standard file browser to locate and 

select the desired file.
• Type the full path to the desired file.

2. Once a valid file is selected, click Next > to see the screen shown in 
Figure a-5.

Figure a-5. Setting Fixed Width File Columns in Data Source Wizard

3. Adjust the blue lines until you are satisfied with the column layout.
• To move a line, click and drag.
• To add a line, hold Shift and click the desired location.
• To delete a line, hold Ctrl and click on the line to be removed.

4. Click Next > and proceed with Step 3 on page 9.

Using SQL Databases
If you selected to import your data from a JDBC / ODBC Data Source (Step 
1 on page 6) the Data Source Wizard will look like what is shown in 
Figure a-6.
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Figure a-6. JDBC Connection Setup for Data Source Wizard

Follow these steps to configure the data source:

1. Select the Driver from the drop-down menu of available drivers.
2. Once a driver is selected, the Data Source Wizard window shows 

parameters for that driver if Quantrix recognizes the driver. If 
Quantrix does not recognize the driver, you will be prompted to 
enter the JDBC URL for that driver. See the driver documentation 
for details on the URL format for your driver.

3. Optionally test the connection by clicking Test Connection. You 
will be prompted for the username / password to associate with this 
connection.

4. Click Next > to continue. If you did not test the database connec-
tion, you will now be prompted to enter the username / password for 
the database connection.

Note:  If you place a check in the Save password checkbox, Quantrix 
will save the password for this database connection on your machine. The 
password will not be in the model file and you will have the ability to edit 
the username and password for future connections.

5. If the database connection is successful, you will see a screen that 
looks like what is shown in Figure a-7.
Quantrix Modeler DataNAV User Guide Supplement



12
Quantrix DataNAV 

Configuring Data Sources
Figure a-7. Columns Tab of Data Source Wizard

On the left of the Wizard is a list of the tables available in the 
database. Click the plus icon (  ) to the left of the table name to 
display the table’s available columns.

6. Add columns to your query by double-clicking the column names in 
the list at the left of the window. The columns will show up in the 
right-hand side. Quantrix may ask you to help it decide how to link 
the tables if it cannot detect the linkage (join) automatically.

Figure a-8. Selecting Columns to Import in Data Source Wizard

7. If necessary, you can manually edit the table joins on the Tables tab 
of the Data Source Wizard window as shown in Figure a-9.
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Figure a-9. Setting Table Joins in Data Source Wizard

Using the Tables tab you can change the table joins in the following 
ways:
• Alias - this is the name used elsewhere in the query to refer to the 

table. Changing the Alias will automatically update the other refer-
ences to this table.

• Type - this specifies whether a corresponding row in the table 
needs to be present for the query to return it. This setting allows 
for inner joins, shown as required (default), and left outer joins 
shown as optional.

• From - this is the column in the table being used to link or join to 
the To column in another table.

• To - this is the column in another table in the query which is used 
to compare with the From column to establish the join.

Note:  You can establish more sophisticated joins using the SQL tab. 
See“Using SQL Expert Mode” on page 14 for more information on using 
the SQL tab.

8. If desired, you can add a qualifier to your query to filter only the rows 
you would like to analyze using the Qualifiers tab as shown in 
Figure a-10.
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Figure a-10. Setting Qualifiers in Data Source Wizard

To add a qualifier, double-click on the column in the list on the left of 
the Data Source Wizard window to add a column qualifier to the quali-
fier tab. You can then set the logic of the qualifier using the drop-down 
menus and fields in the lower left corner of the Qualifiers tab. 
9. To see the resulting SQL at any time during the process of building 

your query, you can click on the SQL tab. 
10. When you are satisfied with the query, click Next > and continue 

with Step 3 on page 6 to complete the data source setup.

Using SQL Expert Mode
The query builder in the Data Source Wizard can help you construct simple 
queries with straightforward qualifiers and joins. If you need to execute 
more complex queries or if you prefer to enter your SQL manually, you can 
click the SQL tab. This will present you with a SQL editor that will allow 
you to type your SQL in manually as shown in Figure a-11. 
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Figure a-11. Using SQL Expert Mode in Data Source Wizard

Tip:  If you have existing SQL that you would like to use within Quantrix, 
you can use the clipboard to paste it directly into the SQL tab of the Data 
Source Wizard.

You can use expressions in your SQL statement to point to cells in your 
model to set dynamic variables in the SQL command. While in SQL expert 
mode, use the curly braces {} to surround your expression statement. To 
learn more about expressions, see “Expression Concepts” on page 200 of 
the Quantrix Modeler User Guide.

Using Web Services / SOAP
If you selected to import your data from a Web Services / SOAP (Step 1 on 
page 6) the Data Source Wizard will look like what is shown in Figure a-12.

Figure a-12. Opening Web Services Screen of Data Source Wizard
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Follow these steps to configure the Web Services / SOAP Data Source:

1. Enter the URL for the Web Services Description file (WSDL).
2. Click Next > to continue to this screen shown in Figure a-13.

Figure a-13. Selecting Web Services Operation in Data Source Wizard

3. Use the plus icons (  ) in the tree at the left to expose the available 
services. Select the service you would like to invoke by clicking on the 
label.

4. Click Next > to continue to a screen shown in Figure a-14.

Figure a-14. Select Web Services Parameters in Data Source Wizard

5. The Data Source Wizard will list the parameters of the Web Services 
call you are invoking. Fill these in with the relevant values to 
configure the Web Services invocation.

6. Continue from Step 3 on page 17 to configure the XML fields you 
would like to import.
Quantrix Modeler DataNAV User Guide Supplement
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Configuring Data Sources
Using XML Files
If you selected to import your data from an XML Data Source (Step 1 on 
page 6) the Data Source Wizard will look like what is shown in Figure a-15.

Figure a-15. Opening XML Screen of Data Source Wizard

Follow these steps to configure the XML Data Source:

1. Use the radio buttons to select the source of the XML data.
• XML file - the file is located on a file system available on your 

computer.
• URL - the file is accessible via HTTP or FTP on the Internet.

2. Enter the url or file path into the Source location field. If you 
selected XML file, you can click the Browse... button to use the file 
browser to locate the xml data file.

3. Click Next > to get to a screen like what is shown in Figure a-16. 
The tree on the left represents the structure of the XML document. 
You can navigate the structure by clicking the plus icons (  ) to open 
elements and expose their children. The list on the right indicates 
which fields from the XML you will be importing.
Quantrix Modeler DataNAV User Guide Supplement



18
Quantrix DataNAV 

Configuring Data Sources
Figure a-16. Navigating XML Source with the Data Source Wizard

4. Double-click on the elements or fields you wish to import. They will 
show up in the right pane.

5. Set the data type for each field using the drop-down menu in the 
Data type column.

Figure a-17. Selecting XML Source Data with Data Source Wizard

6. Click Next > and continue with Step 3 on page 6 to complete the 
data source setup.
Quantrix Modeler DataNAV User Guide Supplement



19
Quantrix DataNAV

Configuring Data Sources
Name New Data Source
Once the data source connection is established you will create a name for 
the new data source. Click Finish to proceed to use the data source in an 
aggregation query.

When finished, the table you specified is made available for Quantrix aggre-
gation queries. Quantrix will inspect the table and if foreign key constraints 
are present in the database Quantrix will link the joined tables automatically. 
If foreign key constraints are not present you can manually establish the 
joins. See “Add Join Table” on page 27 for more details.
Click on the plus icon (  ) next to the data source name to review the 
columns and linked tables for the data source.
Quantrix Modeler DataNAV User Guide Supplement
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Using DataNAV
Once a data source is created, you can use it to create categories and data 
items in matrices.

Create Categories 
To create an aggregated category, drag the category tile icon from the 
column to a category tray in the desired matrix. With each column in the 
database, you can create one or more of these three different types of 
categories. If desired, during configuration you can choose to sort the 
category values.
The type is pre-determined by the database. If more than one option is 
available, you will be able to choose in the Configure Dimension dialog 
box as shown below.

• All Values - Each unique value in the column will become an item in 
the category.

• Bin Quantizer - The unique values in a category can be binned into 
ranges.

• Date Field Quantizer - Each unique date in the column can be 
aggregated into separate year, month or day dimensions. Additionally, 
date formats can be applied for different date displays in the 
category. 
Quantrix Modeler DataNAV User Guide Supplement
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To apply a date format, follow these steps:

1. Drag the Date category tile to the desired matrix.
2. In the Configure Dimension dialog box, choose the appropriate 

date components from eleven options available in the drop-down 
menu as shown below.

To include additional fields, click the Add button. You may also 
choose to display a field separator by clicking on the drop-down 
menu that appears between the two date fields. Choose from the 
six available options as shown.

3. Press OK to complete the date field formatting.

Tip:  To view the source of a Category or Data Item, hover the cursor 
over the item name. A tooltip displaying the Data Source, Table, Field and 
summarization method, when used, will be shown.
Quantrix Modeler DataNAV User Guide Supplement
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Using DataNAV
Linked DataNAV Categories
When two matrices need access to the same DataNAV category, you can 
link the category (and all of its items) across the matrices just as you would 
any other model category. For more information on linked categories, see 
“Using Linked Categories” on page 125 of the Quantrix Modeler User Guide.

Caution:  In DataNAV, linked categories share any DataNAV Qualifier 
restrictions placed on the category in the originating matrix. For more infor-
mation on DataNAV Qualifiers, see “Applying Qualifiers” on page 23.

Create Data Item
Each column in the data source can be an aggregated Data Item. While some 
databases may have expanded statistical functions available, most databases 
will have these standard types of data items:

• Count
• Minimum
• Maximum
• Sum
• Average
• Variance
• Weighted Average 

To create a weighted average item, follow these steps:

1. Drag the data item to the table of the desired matrix.
2. Select the Weighted Average option from the drop-down menu as 

shown.
Quantrix Modeler DataNAV User Guide Supplement
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3. In the Configure Data Item dialog box, choose the numeric field 
on which to base the weighted average as shown below. All 
numeric fields available appear in the drop-down menu. 

Categories and data items can be placed into matrices, table views, chart 
views and views on a presentation canvas. Simply click on the appropriate 
data item and drag it into the table of the matrix as shown below
.

Applying Qualifiers
Any column can be used as a qualifier for the aggregation query. To create a 
qualifier, first click the drop-down arrow in the formula pane and switch to 
DataNAV Qualifier mode.
Quantrix Modeler DataNAV User Guide Supplement
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Using DataNAV
Then simply drag a column point (category or data item) into the qualifier 
area of the matrix window and set the qualifier parameter.

Tip:  To increase processing speed while applying qualifiers, turn off the 
Auto Refresh feature by choosing Data > DataNAV > Auto Refresh. This 
will prevent Quantrix from querying the database with each qualifier edit. 
Click the Update Data icon ( ) in the toolbar to refresh manually.
Quantrix Modeler DataNAV User Guide Supplement
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You can create multiple qualifiers and join them with AND / OR 
statements. 

Building qualifiers is essentially creating the WHERE conditions of the SQL 
query being passed to the database for processing.
To duplicate queries for multiple matrices, select the entire qualifier and drag 
to the desired matrix.

Remove Matrix DataNAV Links
Matrices containing data from a DataNAV source will display a DataNAV 
link icon ( ) on the matrix in the Model Browser and Matrix Title Bar.
Once the matrix is populated with the data, you may want to remove the 
link to keep the data static. To remove the DataNAV link, follow these steps:

• Highlight the appropriate matrix in the Model Browser
• Choose Data > DataNAV > Remove Matrix DataNAV Links

Caution:  Removing matrix DataNAV links will also remove any 
DataNAV Qualifiers that have been established in the DataNAV Qualifier 
pane.
Quantrix Modeler DataNAV User Guide Supplement
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Setting General DataNAV Options
You can apply some DataNAV options to all of your Quantrix files using 
the Options dialog box. To open it, choose Tools > Options.

Figure a-18. The Options dialog box

There are three options related to DataNAV files. To change the default 
settings, follow these steps:

1. Choose Tools > Options to open the Options dialog box
2. Click on the DataNAV section of the Options dialog box
3. Change the following options as desired:

• Field Enumerated Values Limit - sets the maximum number of 
items to appear in the DataNAV qualifier drop-down list

• Field Unique Items Limit - sets the maximum number of items 
that will be created in a DataNAV category

• Use inferred Like qualifier syntax - when selected, Quantrix will 
imply the SQL ‘%’ in all Like queries

4. Click the OK button to apply the options
Quantrix Modeler DataNAV User Guide Supplement
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Modifying DataNAV Data Sources

Add Join Table
Some databases and other data sources do not broadcast which tables are 
related to each other. With Quantrix, you can establish the joins between 
tables manually through the data source panel. 
To establish joins between tables do the following:

• Right-click on the data source name and choose Add Join Table...

• From the Add Join Table panel, choose the table you want to link to 
and the common column in each table that establishes the link

Note:  The Add Join Table option is only available when using a 
DataNAV JDBC / ODBC Data Source.

Add Custom Fields
You can add a virtual column in a data source. An example would be to take 
two columns and perform a mathematical operation (average, multiply, 
addition). Doing this allows you to use the database as the processing engine 
for the column and then use the results in a matrix using the aggregated data 
source.
To establish a custom field do the following:

• Right-click on the data source name and choose Add Custom 
Field...
Quantrix Modeler DataNAV User Guide Supplement
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Modifying DataNAV Data Sources
• In the Add Custom SQL Field panel, enter the name of the new 
field in the Field Name box and then write the SQL statement for the 
new virtual column.

• .Select Verify SQL to check the validity of the SQL statement.

Tip:  Use a different formatting style, all capital letters for example, to 
differentiate custom fields from the fields that are part of the data source.

Note:  The Add Custom SQL Field option is only available when 
using a DataNAV JDBC / ODBC Data Source.

Tip:  When configuring a DataNAV, any missing or invalid names are 
signified by a red X warning ( ). 

Remove Data Source
Remove a data source from the model in one of these ways:

• Right-click on the data source name and choose Remove

• Click on the Remove Data Source icon ( ) 
Quantrix Modeler DataNAV User Guide Supplement
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Create a Two Dimensional Query
With Quantrix DataNAV you can create a Two Dimensional Query from any of 
your model data sources. Items in a Two Dimensional Query are not data 
items and no summarization methods will be applied. See “Create Data 
Item” on page 22 for more information about data items.
You can apply DataNAV Qualifiers to a Two Dimensional Query as you 
would in any other matrix. See “Applying Qualifiers” on page 23 for more 
information.
You create a Two Dimensional Query in one of the following ways:

1. Using the All Rows column:
• In a new matrix, drag the All Rows column from the appropriate 

data source or linked table to any category tray
• Drag all desired columns to the table of the matrix

2. Using Two Dimensional Query:
• Right-click on the appropriate data source or linked table
• Select Two Dimensional Query from the pop-up menu
• Select the columns to include in the query from the Select Fields 

dialog box as shown in Figure a-19
• A new matrix is created from your choices

Figure a-19. Create a Two Dimensional Query
Quantrix Modeler DataNAV User Guide Supplement
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Updating DataNAV Queries

Modifying DataNAV Categories
You can modify categories created by DataNAV to adjust the bin settings, 
auto-summarize or update the items. To modify DataNAV categories do the 
following:

• Right-click on the Category Tile of the DataNAV item and choose 
DataNAV from the pop-up menu. Then choose one of the following 
menu items:
• Configure Dimensions - If the category was originally created as 

a date or bin, clicking Configure Dimension shows the panel that 
allows you to adjust the date or bin settings.
As shown in the bin configuration below, you can set the start and 
width of the bin as well as apply a number format. Clicking OK 
will reset the bins with the new information entered in the panel.

• Auto Summarize - This option adds a new summary item to the 
category and executes a SQL query to the data source for the 
summarized results of the dimension.

• Update Items - Updates the category items with any new infor-
mation from the data source.
Quantrix Modeler DataNAV User Guide Supplement
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Adding and Modifying Items Manually in 
DataNAV Categories

Renaming Items
Items in DataNAV categories can be renamed as desired. The new name 
will remain when DataNAV queries are updated.

Adding and Deleting Items
New items can be added to DataNAV categories and can be used in the 
normal modeling process. You can add a new item to a category just as you 
would in any regular category. Simply click on an item and press the 
ENTER key or choose Insert > Add Item from the menu.
Items can also be deleted from DataNAV categories. It is important to 
know that deletion of items created by a DataNAV category will return with 
the next data source update.
To permanently remove an aggregated item from a category, use a qualifier. 
For more information see “Applying Qualifiers” on page 23.

Auto Refresh DataNAV Queries
Deletion and additions of categories and items in a matrix can automatically 
refresh the DataNAV query. To turn this setting on or off, choose Data > 
DataNAV > Auto Refresh

Update Data
Aggregated queries in a matrix that is not refreshed automatically can be 
refreshed by choosing Data > DataNAV > Update Data. You can also 
click the Update Data icon ( ) in the toolbar to refresh the matrix data.

Update All
All the aggregated queries in a model that are not refreshed automatically 
can be refreshed by choosing Data > DataNAV > Update All.
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DataNAV Drill Down
Once you have created a DataNAV query that contains summarized data, 
you can drill down to see a list of the transactions that make up the data in an 
individual cell. 
To see the data detail, right-click on the summarized DataNAV item and 
choose Drill Down from the menu.
A list of columns that make up the DataNAV summarized values will be 
displayed. Choose the columns in the DataNAV Drill Down results 
window that you would like to use to create a new query.

Figure a-20. Create DataNAV Drill Down Query

The results of the Drill Down will be displayed as shown in Figure a-21 on 
page 33.
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Figure a-21. DataNAV Drill Down Results

Select one of the options from the bottom of the DataNAV Drill Down 
results window to use the data in the following ways:

• Create Matrix - creates a new two dimensional matrix with the 
results of the query

• Create Data Source - use the query results as a new data source for 
the current model

Using the Data Source Library
Each DataNAV Data Source exists with the model in which it was created. 
This enables the data source to be available when the model is shared. 
Quantrix allows you to create a static copy of a model data source that can 
be used in other models by adding it to a library of data sources.

Add to the Library
To save a static copy of a data source, making it available for other models, 
follow these steps:

1. Open the Data Sources panel by clicking on the Data Source icon 
( ) in the toolbar.

2. Right-click on the data source to be saved and select Add Source to 
Library.
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Note:  This is a static copy and will not be updated with changes to the 
original data file. To import the most current data file, see “Editing a Data 
Source” on page 34.

Editing a Data Source
To edit an existing data source, follow these steps:

1. Open the Data Sources panel by clicking on the Data Source icon 
( ) in the toolbar.

2. Right-click on the data source to be edited and select Edit Data 
Source...

This opens the Data Source Wizard allowing you to make adjust-
ments to all of the original settings. For more detailed instructions see 
“Adding a JDBC / ODBC Data Source” on page 4 or “Adding a 
Local Data Source” on page 5.

Tip:  To save the edited data source as a new data source, enter an new 
name in the Data Source Wizard when prompted.
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Deleting a Library Data Source
To delete a data source from the library, follow these steps:

1. Open the Add Data Source Wizard in one of these ways:
• Click on the Add Data Source icon ( ).
• Right-click on an existing data source and select Add Data 

Source from the pop-up menu.
2. Choose the data source to be deleted from the Add data source 

from library list.
3. Click Delete.

The data source is removed from the library but remains active in any saved 
models that use this data source.

Using a Library Data Source
To use a Data Source from your DataNAV library, click on the Add Data 
Source icon ( ) or right-click on an existing Data Source and choose Add 
Data Source to start the Data Source Wizard.

When you select a Data Source from the Add data source from library 
option, you will see the details of the original Data Source setup. Select 
Next > to proceed through the steps of setting up a database connection as 
described in “Adding a JDBC / ODBC Data Source” on page 4 and 
“Adding a Local Data Source” on page 5. This process allows you to make 
changes to the original parameters.
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Tip:  To add a Library Data Source as a new Data Source without any 
changes, double-click on the Data Source name.

Note:  Any changes made during this setup process will not be saved to 
the library unless you add it to the library as a new Data Source. See “Add to 
the Library” on page 33 for more information.

DataNAV Permissions

Permissions
Quantrix allows you to grant specific permissions related to DataNAV to 
each role to control how the model is used by others.
The following tables provide details on the additional settings at each level. 
For information on creating roles and all of the permissions available in 
Quantrix Modeler, see “Protecting a Model” on page 358 of the Quantrix 
Modeler User Guide.

Edit Structure Settings
These role specific settings for DataNAV apply to the currently active 
model.

Allow Interaction Settings
These role specific settings for DataNAV apply to the currently active 
model.

Setting: Description:

Modify Data Sources Allows editing of established DataNAV Sources

Modify DataNAV Query
Allows editing of established DataNAV queries in all 
or selected matrices

Update
Allows updating of established DataNAV links in all 
or selected matrices

Setting: Description:

Open Data Source 
Browser Allows interaction with the Data Source Browser
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